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[bookmark: _Toc510682701][bookmark: _Toc22058889]ABSTRACT
This study examines the factors contributing to Extended Working Hours (EWH) at a financial institution in Malaysia. Guided by the Job Demands-Resources (JD-R) theory, it investigates how job demands, such as workload and understaffing, and job resources, including financial incentives and career advancement opportunities, influence employees’ working patterns. Extended working hours are increasingly common in the financial sector, where performance expectations, client demands, and regulatory responsibilities pressure employees to exceed standard working hours. Data was collected from 106 non-executive employees across various departments and analyzed using IBM SPSS Statistics, which enabled descriptive analysis, reliability testing, and hypothesis testing to determine the significance of the proposed relationships. The findings revealed that three of the four hypotheses were supported: workload, financial incentives, and career advancement opportunities significantly influenced EWH, whereas understaffing did not. These results suggest that employees are more likely to work beyond normal hours due to motivational and performance-related factors rather than staffing shortages. The study provides practical recommendations for human resource managers and organizational leaders to improve workload management, optimize incentive structures, and foster a healthier work-life balance. Additionally, it contributes to the theoretical understanding of EWH in the Malaysian financial sector and identifies avenues for future research on employee well-being and organizational productivity.
Keywords: Extended Working Hours; Job Demands-Resources Theory; Workload; Financial Incentives; Career Advancement; Employee Well-being.
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On the Insert tab, the galleries include items with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. look.
You can easily change the formatting of selected text in the document text by choosing a look for the selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using the other controls on the Home tab. Most controls offer a choice of using the look from the current theme or using a format that you specify directly.
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INTRODUCTION
[bookmark: _Toc510682710][bookmark: _Toc22058900]UNITEN Structure C Project Template
This guide has been developed to assist Structure C students in preparing and writing their Business Project Report adopted by the UNITEN. It provides clear directions on the contents, structure, and formatting style to be used for each chapter, ensuring consistency and academic rigor across submissions. The Business Project represents an opportunity for students to integrate theory with practice, applying management and analytical tools to real-world business issues.
Introduction
Introduce your topic starting from a global perspective. Explain how is the topic important and relevant to the current context and era. Add simple definitions and explanations on important terms in the title. 
Background of the Study
This section is to describe the motivation of conducting the study. Explain the business context by clearly stating the  industry overview in the perspective of the country the study is conducted, company profile (if applicable), and the issue or opportunity being addressed.
Problem Statement
Describe the core business problem, challenge, or gap identified. The statement should be specific, measurable, and relevant.
Research Objectives
Clearly list what the project aims to achieve (e.g., “to analyse…”, “to develop…”, “to evaluate…”)	
Research Questions
Frame the key questions to answer your research objective and study.
Scope of the Study
Define the boundaries. Explain what will and will not be covered
Significance of the Study
Explain why this project is important to the industry, organization, and the academic field
Organization of the Chapters
Briefly describe what each chapter contains (from Chapter 1 to 3 for BP1 and Chapter 1 – 5 for BP2).
Chapter 1: Introduction
Chapter 1 sets the foundation of the project by presenting the 1)Introduction; 2)Background of Studies; 3)Problem Statement; 4)Research Objectives and Questions; 5)Scope of Study; 6)Significance of the study; and 7)Organisation of Chapters. Students should begin by providing an overview of the business context, identifying the key issue or opportunity that justifies the project. The chapter should then outline the purpose of the research, list specific objectives, and explain the importance of the study to the organization or industry. It should conclude with a brief description of how the report is structured.
Use the Heading 1 style (UNITEN Chapter Title) for the main chapter title, followed by Heading 2 and Heading 3 for subheadings such as Background of the Study, Problem Statement, and Research Objectives. Ensure to start numbering of page one (1) from the beginning of chapter 1 (as the previous page) and select English (United Kingdom) for language. The rest of the format guidance is explained in detail in Chapter 2 of this template. 
Chapter 2: Literature Review
Chapter 2 discusses relevant theories, models, and empirical studies that support the project. This chapter demonstrates your understanding of the conceptual and theoretical framework that underpins your research. Students should synthesize scholarly sources, compare findings, and highlight gaps that justify the project focus. 
This chapter also provides a guide on the format styles to be used in the project report. In general, Heading 1 style is used for the chapter title, while Heading 2 is used for major sections such as Theoretical Framework, Conceptual Framework, and Empirical Studies. Students should make sure to use the UNITEN Paragraph for all other paragraphs. Figures and tables should follow the template’s Caption for Figure UNITEN and Caption for Table UNITEN styles to ensure consistency and professional presentation. 
Chapter 3: Research Methodology
Chapter 3 explains how the project is carried out, outlining the research design, data collection methods, sampling techniques, and analytical approach. Students are expected to justify the choice of research method used, for example if they use qualitative, quantitative, or mixed mode method for data collection. It is important to describe how data will be gathered and analysed to meet the project objectives. Ethical considerations should also be mentioned where applicable.
Formatting should adhere to the Structure C style use Heading 2 for sections such as Research Design, Data Collection, and Data Analysis Methods. Equations, diagrams, and models can be inserted using the Caption for Equation UNITEN style for labelling.
Chapter 4: Data Analysis and Discussion
Chapter 4 presents the results of the project and interprets the findings in light of the literature reviewed earlier. Students should analyse the data using appropriate quantitative tools (e.g., descriptive statistics, regression, trend analysis) or qualitative methods (e.g., thematic analysis, content analysis).
This chapter should also discuss the implications of the findings, highlighting trends, relationships, and managerial insights. Graphs, charts, and tables should be properly labelled using the provided caption styles. A good research project will be able to interpret the results by linking each finding to the objectives and theories discussed in Chapter 2.
Chapter 5: Conclusion and Recommendations
The final chapter summarizes the study and provides evidence-based recommendations for the organization and industry. Students should revisit the research objectives and clearly state whether they were achieved. The conclusion should synthesize the main findings, discuss the practical and theoretical implications, and suggest future areas of study or improvement.
Maintain the same structured heading hierarchy and formatting consistency as in previous chapters. Ensure that recommendations are specific, actionable, and realistic, based on the data analysed.
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LITERATURE REVIEW
[bookmark: _Toc510682719][bookmark: _Toc22058910]Introduction
The purpose of this chapter is to review relevant theories, models, and previous studies that form the foundation of your business analysis. Typically, your business project should include the subtopics stated in the following paragraphs to ensure rigor of your business project. 
Conceptual Framework
In this section, students should discuss the key business and management concepts related to the topic (e.g., marketing strategies, financial models, operational efficiency).
Theoretical Background
Present relevant theories (e.g., Porter’s Five Forces, SWOT, Balanced Scorecard, Lean Management) that guide your project.
Literature Review
Review previous research findings to show how other scholars or practitioners approached similar issues. 
Gaps in Study
The gap in studies refers to the missing or unexplored area identified from past research or existing literature that your project seeks to address. Synthesis the literature by identifying patterns, contradictions, and research gaps that justify your project focus. When reviewing prior studies, students should identify inconsistencies, limitations, or unanswered questions that justify the need for the current research. Clearly stating the research gap demonstrates the originality and relevance of the project.

Example: “While previous studies have examined customer satisfaction in retail banking, limited attention has been given to how digital service quality influences satisfaction among Generation Z customers in Malaysia (Phang et.al. 2025).” Upon identifying the gaps in the research and using these gaps, raise the hypothesis for the study.
Hypothesis Development
The hypothesis development process involves formulating testable statements that predict relationships between variables, based on the literature review and theoretical framework. A good hypothesis reflects logical reasoning, is grounded in prior research, and can be empirically tested using data. Hypotheses may be directional (predicting the nature of the relationship) or non-directional (predicting that a relationship exists without specifying its direction). Example of a hypothesis raised is as shown below : 
H1: There is a positive relationship between digital service quality and customer satisfaction among retail banking customers.
H2: Perceived trust mediates the relationship between digital service quality and customer loyalty.
Proposed Framework (if applicable)
Illustrate the framework or model guiding your analysis. Use recent (the last five years), credible sources (journals, reports, business cases) and link each concept to your project context.
[bookmark: _Toc510682711][bookmark: _Toc22058902]Project Report formatting 
To create a new project report based on this template, just double click the file. A new document will open in Microsoft Word, normally named Untitled.docx. You can start put your content in that file without having to worry about the thesis formatting. However, if you want to apply this dotx template to your current thesis, you need to enable the Developer Tab option. To do so, please refer to Figure 1.2.
[image: A computer screen shot of a computer
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[bookmark: _Ref461057537][bookmark: _Toc22058948]Figure 2.1	Enabling the Developer Tab
Source: Zuli (2016). Use style named Caption for text in Figure UNITEN for any text here.

Formatting of Headings 
The rest of the chapter is describing the styles to be used in the report. 
Heading 1
Heading 1 is used for chapter naming. In this template, it is called Heading 1, UNITEN Chapter Title. In most cases, thesis will have around five to seven chapters.
[bookmark: _Toc510682720][bookmark: _Toc22058911]Heading 2
The styles used for this subchapter 2.89 is Heading 2, UNITEN Level 2.
[bookmark: _Toc510682721][bookmark: _Toc22058912]Heading 3
The heading for Subchapter 2.98.1 is formatted with Heading 3, UNITEN Level 3.
[bookmark: _Toc512845402][bookmark: _Toc22058913]Heading 4
The heading for Subchapter 2.8.1.1 is formatted with Heading 4 UNITEN Level 4.
[bookmark: _Toc510682722]Heading 5
In this template, Heading 5 is not numbered. Instead, the heading for level 5 will be using ‘i)’ the Heading 5, UNITEN Level 5.
Heading 6
In this template, Heading 6 is not numbered. Instead, the heading for level 6 will be using ‘a)’ the Heading 6, UNITEN Level 6.
[bookmark: _Toc510682724][bookmark: _Toc22058916]UNITEN Paragraph
All styles developed in this template are essential to a proper thesis formatting. The most widely used style is UNITEN Paragraph. This very paragraph is formatted by UNITEN Paragraph.
Figure and Table formatting
When inserting figures and tables into the project report, students must use the References tab in Microsoft Word to ensure consistent formatting and automatic numbering. To do this, click on the References tab and select Insert Caption. In the dialog box, choose the appropriate label; ‘Figure or Table’ and click on the Numbering button. Ensure that the option “Include chapter number” is ticked so that each figure or table is numbered according to its chapter (for example, Figure 1.3 or Table 2.5). If the figure or table is adapted or obtained from another source, select the caption style “Source” and type the source where the information is adapted or adopted from.  The source statement should appear below the figure caption or at the bottom of the table, aligned with the figure and table respectively.
Caption for Figure
After setting the numbering, select the corresponding caption style from the template. For figures, choose “Figure Centre UNITEN.” This ensures that all figures are centered and consistently formatted according to the UNITEN template style. The figure caption must be clear, concise, and descriptive of the figure’s content. Please take note that the caption Figure is labelled at the bottom of the image. Refer to Figure 2.1 as an example. 
[image: A diagram of a method
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[bookmark: _Toc22058947]Figure 2.4	 MZJ Ideas on formatting 


[bookmark: _Toc22058908]Caption for Tables
Once the PC is ready, you can familiarize yourself with the styles in this template. Some of the styles will be explained in Chapter 2.
Table 2.2	Title of table
	NO
	ITEM
	SOURCE
	REFERENCE

	
	
	
	

	
	
	
	



[bookmark: _Toc22058881][bookmark: _Toc510682712][bookmark: _Toc22058903]Table 2.3	Base and supplementary units in SI system.
	Unit type
	Quantity
	Unit name
	Unit symbol

	Base units
	Amount of substance
	mole
	mol

	
	Electric current
	Ampere
	A

	
	Length
	Meter
	M

	
	Luminous intensity
	Candela
	Cd

	
	Thermodynamic temperature
	Kelvin
	K


Source	: State the source here


Table setting for continuity to next page
When a table extends to the next or following page, it is important to repeat the table heading row for clarity and consistency. To do this, first select the heading row (usually the top row of the table that contains the column titles) or select the table. Then, right click and select ‘Table Properties’. Go to the Table Row menu, tick and select the two options as shown in Figure 2.5. This will ensure that the heading automatically appears at the top of each subsequent page where the table continues.
[image: A screenshot of a computer

AI-generated content may be incorrect.]
Figure 2.5	Select header for repeating table in following pages

Make sure that the table caption (e.g., Table 2.5	Table that has continuity to the next page) appears only on the first page of the table, while the repeated heading rows on the following pages should not include the caption. This feature maintains professional formatting and readability, ensuring that readers can easily follow the data presented across multiple pages.
[bookmark: _Toc22058883]Table 2.5	Table that has continuity to the next page
	Title 
	Number
	Student 
	Gendet
	Income
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Inserting Cross-References for Figures and Tables
Students may use the Cross-Reference feature when referring to figures and tables within the text. This ensures that all figure and table numbers are automatically updated if any are added, deleted, or moved during editing. To insert a cross-reference, place the cursor at the point in your text where you want to refer to the figure or table. For example, when there is a statement that says “as shown in Figure 2.1”, go to the References tab, click Cross-reference, and under Reference type, select either Figure or Table. From the list displayed, choose the appropriate caption (Reference type : Figure, Table, Equation or others) and ensure to select on ‘Only label and number’ and click Insert.
[image: A screenshot of a computer

AI-generated content may be incorrect.]
Figure 2.6	Cross Reference (optional)

This feature automatically links the caption number to the text, allowing Word to update all references when fields are refreshed. After making any changes to figure or table order, remember to right-click and select “Update Field” to refresh all cross-references throughout the document. This process ensures accuracy, consistency, and professional formatting in your project report.
Navigation Pane
Navigation pane is where you can browse through your thesis based on its heading name. To enable it, please refer to 
[bookmark: _Ref461057127][image: A screenshot of a computer

AI-generated content may be incorrect.]
[bookmark: _Toc22058949]Figure 2.7	Navigation Pane
[bookmark: _Toc510682713][bookmark: _Toc22058904]Styles Pane
The basic of applying template is using the styles on Style Pane (Figure 1.4). Styles is predefined formatting of text and paragraph. It is most efficient that you put the Styles pane on the right side of the Microsoft Word working environment by click a small arrow as shown in Figure 1.7. If your pane is floating, click and hold the windows and put it at the right side of the windows.
[image: A screenshot of a computer
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[bookmark: _Ref526348398][bookmark: _Ref526348394][bookmark: _Toc22058950]Figure 2.8	Style Pane

[image: A screenshot of a computer
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[bookmark: _Ref461058057][bookmark: _Toc22058953]Figure 2.10	Enabling Styles Pane
Once secured on the right side of the working environment, the Styles Pane should look like Figure 2.10.
[image: A screenshot of a computer
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[bookmark: _Ref461058297][bookmark: _Toc22058954]Figure 2.11	Syles Pane on right side of the window
This is just a simulation. Syles Pane on right side of the window Once the PC is ready, you can familiarize yourself with the styles in this template. 
Equations
As shown in  all equations must be systematically numbered. To insert any equation, copy the whole equation and numbering below and paste on your desired location. After that, edit the equation. The style for equation is Caption for Equation UNITEN.
	

	(2.1)


The paragraph after an equation of a figure, has to be formatted in UNITEN Paragraph 2. This is to allow some space between the paragraph and the equation or the figure’s caption. This paragraph is using UNITEN Paragraph 2 style.
[bookmark: _Toc510682725][bookmark: _Toc22058917]Quote
To insert a quote like this, use Quotation UNITEN style. Please ensure all quotation are properly cited.
On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks.
The text in paragraph can be formatted using Table text style. On the other hand, the style for table’s caption is called Caption for Table UNITEN.
Page layout 
The page layout should be portrait and following the margin of this template. If there is a table or figure that only fits a ‘landscape’ layout, students should go to the tab ‘Layout’ and select ‘Breaks’. Under the dropdown menu of breaks, students should select ‘Next Page’ under Section Breaks.    Upon selecting the next page, students may change the layout to landscape as shown in the next page. Make sure to select ‘Next Page’ upon completion of the layout to change back to portrait. 
2

5
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(a) PCR models -SPXY
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(b) PCR models - KS
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(c) PCR-models - Duplex
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(d) PLS models - SPXY
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(e) PLS models - KS
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(f) PLS models Duplex


[bookmark: _Ref282898069][bookmark: _Toc283591094][bookmark: _Toc283591102][bookmark: _Toc283592776][bookmark: _Toc283592807][bookmark: _Toc285404342][bookmark: _Toc285451495][bookmark: _Toc286417130][bookmark: _Toc462667896][bookmark: _Toc22058955]Figure 2.2 	Select Layout ‘Landscape’
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[bookmark: _Toc22058956]Figure 2.3	The atomic packing of a non-dense (random packing) materials.



[bookmark: _Toc22058885]Table 2.1	Title 
	No
	Item
	Purpose

	1
	PCA biplots
	To show the influence of the variables on the samples. This plot is the combination of PCA scores and PCA loadings plot.

	2
	Percentage of eigenvalues
	To show the importance of each PCs. The percentage gives an indication about the variation of the data explained by each PC.

	3
	PCA scores plots
	To show the pattern or the distribution of the samples that may exist.

	4
	PCA loading plot
	To show the pattern or the distribution of the variable that may exist.

	5
	1D of first component scores plot
	To support PCA scores plot of the samples’ distribution by using the highest percentage variances explained PCs







Summary
Students are required to adhere to the prescribed UNITEN Structure C template styles, including heading levels, captions, and numbering formats, to maintain uniformity in presentation. Proper referencing, academic writing conventions, and data presentation practices are essential to ensure the quality and credibility of the Business Project Report.



[bookmark: _Toc510682726][bookmark: _Toc22058918]


RESEARCH METHODOLOGY
[bookmark: _Toc510682727][bookmark: _Toc22058919]Introduction
This chapter outlines the research methodology adopted for the project, explaining how the study was designed, conducted, and analysed to achieve the stated objectives. It describes the overall research approach, the types and sources of data collected, and the methods used for sampling, data gathering, and analysis. The methodology provides a systematic framework that guides the research process, ensuring that the findings are valid, reliable, and aligned with the project’s objectives. The chapter also discusses the rationale behind the chosen methods and highlights the ethical considerations observed throughout the study. By clearly describing the research procedures, this chapter enables readers to understand and, if necessary, replicate the research process.
[bookmark: _Toc510682728][bookmark: _Toc22058920]Research Design
The research design serves as the blueprint for conducting the study. It outlines the overall strategy and structure adopted to integrate the different components of the research in a coherent and logical manner. Depending on the nature and objectives of the project, the research may adopt a qualitative, quantitative, or mixed-method approach.
Quantitative
A quantitative design focuses on numerical data and statistical analysis to test hypotheses and measure relationships between variables.
Qualitative
A qualitative design emphasizes understanding human behavior, experiences, or organizational dynamics through interviews, observations, or case studies.
Mixed-method
A mixed-method design combines both approaches to provide a comprehensive understanding of the research problem.
The chosen design should be clearly justified, showing how it supports the objectives and expected outcomes of the project.
Data Source
[bookmark: _Toc510682730][bookmark: _Toc22058922]This section identifies the types and sources of data used in the project. Data can be classified as primary or secondary:
Primary data
Primary data are collected firsthand by the researcher through tools such as surveys, interviews, observations, or experiments.
Secondary data
Secondary data are obtained from existing sources such as company reports, industry publications, government statistics, and online databases.
Students should explain the relevance of each data source, its reliability, and how it contributes to achieving the research objectives. When using secondary data, it is essential to cite all sources appropriately to maintain academic integrity.
Sampling Method
[bookmark: _Toc510682732]The sampling method explains how the respondents or data points were selected for the study. The choice of sampling technique should align with the research design and objectives. Common methods include:
Probability sampling
Probability sampling is where every individual in the population has an equal chance of being selected (e.g., simple random sampling, stratified sampling).
Non-probability sampling
Non-probability sampling is where participants are selected based on judgment or convenience (e.g., purposive sampling, convenience sampling).
Students should describe the population, sample size, and sampling rationale, explaining how the chosen approach ensures representativeness and minimizes bias.
Data Collection Methods
This section describes the tools and procedures used to gather data. Depending on the research approach, data may be collected through questionnaires, structured or semi-structured interviews, focus groups, document reviews, or direct observations. The data collection process should be described step-by-step to provide transparency.
Students are encouraged to attach instruments such as questionnaires or interview guides in the Appendices for reference. The section should also include details about the timeline, data collection settings (e.g., workplace, online platform), and any challenges faced during the process.
Pilot Test (only for BP2)
Before conducting the main data collection, a pilot study may be carried out to test the effectiveness and reliability of the research instruments, such as questionnaires or interview questions. The pilot study helps identify any ambiguity, bias, or technical issues in the research tools and provides an opportunity to refine questions for clarity and relevance. A small group of respondents, usually from the same population but not included in the final sample is selected for this preliminary test. Feedback from the pilot study is used to make necessary adjustments to the wording, structure, or format of the instruments. Conducting a pilot study enhances the validity and reliability of the data collection process and ensures that the instruments are appropriate for achieving the research objectives.

Ethical Considerations
Ethical integrity is a fundamental aspect of all research projects. This section should describe how ethical principles were upheld throughout the study. Students must ensure that participants were treated with respect and that their rights and privacy were protected.
Key ethical considerations include:
Obtaining informed consent from participants prior to data collection.
Ensuring confidentiality and anonymity of respondents and organizations.
Avoiding misrepresentation or manipulation of data.
Acknowledging all sources of information and avoiding plagiarism.

Ethical approval from the university or relevant organization should be obtained if required, and adherence to ethical guidelines should be documented in this section.
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RESULT AND DISCUSSION 
[bookmark: _Toc510682737][bookmark: _Toc22058929]Introduction
The purpose of the chapter is to present and interpret the findings based on the data collected, linking them to the objectives and literature.
Data presentation
Use tables, graphs, or figures to summarize results.
Findings
Present key patterns or outcomes (e.g., performance trends, customer insights, financial ratios).
Discussion
Compare results with previous literature or theoretical expectations.
Interpretation
Explain what the findings mean for the business — strengths, weaknesses, opportunities, threats.
Managerial Implications
Discuss how decision-makers can apply the findings.

[bookmark: _Toc510682738][bookmark: _Toc22058940]


CONCLUSION AND RECOMMENDATIONS
[bookmark: _Toc510682739][bookmark: _Toc22058941]Introduction
[bookmark: _Toc22058942]To summarize the study, highlight major insights, and propose actionable recommendations. Recap major points from the analysis that address your objectives.
Conclusion
State what the project reveals about the business problem or question.
Recommendation
Provide specific, practical actions for improvement or implementation

Limitation and Future Studies
[bookmark: _Toc510682740][bookmark: _Toc22058944]Acknowledge any constraints (time, data access, sample size) and propose areas for future research or project expansion.
REFERENCES
Use reference manager such as, Zoreto, Mendeley or Endnote to generate references list here.
Use APA 7th edition for referencing
[bookmark: _Toc510682741][bookmark: _Toc22058945]APPENDIX A
SAMPLE APPENDIX 1
For Appendices Heading use TITLE AT ROMAN PAGES style. 

[bookmark: _Toc510682742][bookmark: _Toc22058946]APPENDIX B
SAMPLE APPENDIX 2
For Appendices Heading use TITLE AT ROMAN PAGES style. 
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